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Introduzione



Introduzione

Nella realizzazione di un programma l'interfaccia grafica collegata al codice € di
estrema utilita affinche un qualsiasi utente possa utilizzare il programma.
Nella maggior parte dei casi I'utente non & un programmatore e quindi non e

interessato al codice ma solo al risultato finale.

Per rendere piu facile la vita dell’'utente costruiremo, con Matlab, un’interfaccia
grafica (GUI) mediante la quale l'utente inserira i dati fisici € numerici, per
risolvere diversi schemi di trave, e visualizzera i risultati in termini di deformata,
di diagrammi delle sollecitazioni e di diagramma dell’errore tra la soluzione

esatta e quella approssimata.



Introduzione

L'interfaccia realizzata per il nostro programma € la seguente

(B o..rem NEIEE
File Analisi Visualizza Esporta

S b X[~ ®mEB

RISOLUTORE TRAVI CON FEM

— DATI

Scema di trave

appapp )

Dimensione trave
L= o

Inerzia Sezione Generica

1= o vai e INSERISCI | DATI

| E

e e CLICCA SUL PULSANTE
CALCOLA

Numero di elementi
nx =po | m

Carico distribuito
q= 0 Nimm

Calcola ] [ Reset

la quale e composta da:



Introduzione

0 sezione dedicata allimmissione dei dati e alla scelta del tipo di struttura:

— DATI
B oD Fem =B X
File Analisi Visualiza | g dit ~
‘appapp v
2 : RAVI CON FEM
it Dimensione trave
Scema di trave L= ;5500 | mm
appapp. ': ' ' ' ' ! T
Dimerisionie Lrdse Inerzia Sezione Generica -
L = |s500 ot ;

: I= [3.01e+007 mm"4 i
Inerzia Sezione Generica‘;~ W = —
1= l301e+007 | [vai jmm y : .

‘ Materiale
Materiale I b
: I = | Nimm*2 é é
E= 210000 Mimm?2 E 7._21 0000 | 7
R2= 275000 N
Mumero di elementi : : 7
- . Mumero di elemgntl i
nX =100 n .
Carico distribuito 1
q= 100 Nimm ! ] ! ] T
|| Carico distribuito 2000 3000 4000 5000 6000
Calcola Reset .
[ Calcola | [ Reset ]




Introduzione

0 sezione dedicata alla visualizzazione dei diagrammi di output

B 0.0 Fem - =B X
File & —_—r

™
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oimg 1000
500 s

Ine

2 0F
vald 500 [ él él "
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-1000
Mur
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-2500

| | | | | |
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Introduzione

0 Barre dei menu e degli strumenti

- D D _FEM - ' . - = E] X
File Analisi Visuali o

S File Analisi Visualiza | Esporta

— DATI

Scema di trave

awoapp Lo
D‘i)r: :: sione trave -t h {-} T.l E

L = 'ss00
Inerzia Sezione Generica 1000 - -
I= |s01es007 \ mm/~4 500 L 2
Materiale 0F 7
E= 210000 NAnm*2 500 |- él él .
- ' R1= 275000 N R2= 275000 N
’ ; 1000 -
Numero di elementi
nx =‘ii00 n 1500 -
-2000 | -
Carico distribuito 2500
q= 100 | MAmm 2 [ 1 1 1 1 1 ] |
= : 0 1000 2000 3000 4000 5000 6000

[ Calcola ] [ Reset




Realizzazione dell’interfaccia utente
con Matlab



Realizzazione di un’interfaccia utente con Matlab.

Dopo aver avviato Matlab per aprire I'editor di GUI possiamo procedere in tre
modi:

1. clicchiamo dal menu (File -> New -> GUI );

2. dalla barra degli strumenti clicchiamo la seguente icona [‘_?f

3. digitiamo direttamente nella finestra dei comandi (guide).
Si avvia in questo modo la seguente finestra.:

Create New GUI | Open Existing aul|

GUIDE templates
4\ Blank GUI (Default)

4\ GUI with Uicontrols

4 GUI with Axes and Menu
4\ Modal Question Dialog

Preview

Selezioniamo la voce

Blank GUI (Default)

e clicchiamo sul pulsante OK

[C] Save new figure as: |C:\Users\DANILO\Documents\MATLAB\untitled1.fig

[ ok ][ cancel




Realizzazione di un’interfaccia utente con Matlab.

Si apre I'editor di GUI che si presenta come segue:

=
‘ E_sfy‘ untitled1.fig ag“

File Edit View Layout Tools Help

NEH R o[ 2EMmd SH% [P

i k Select

[ Push Button

| = Slider

[ @ Radio Button
Check Box
o7 Edlit Text

4T Static Text

&3 Pop-up Menu

]
]
]
[ ]
| )
| ]
[ )
| =l Listoox ]
[ ]
[ ]
[ ]
| ]
]
)

[ Toggle Button
E Table
i&‘.’ Axes

(%] Panel

[ ™8| Button Group
L =X ActiveX Control

| Current Point: [297,6] | Position: [520, 380, 560, 420]

L'editor presenta in alto una barra dei menu e una barra degli strumenti, a sinistra
troviamo la barra degli oggetti che possiamo inserire nella nostra interfaccia e
al centro troviamo l'area di lavoro.



Realizzazione di un’interfaccia utente con Matlab.

Per realizzare il nostro programma inseriamo inizialmente un oggetto (Static Text)
nell’area di lavoro. Per modificare il testo visualizzato facciamo doppio click
sull’oggetto e apriamo la finestra delle proprieta (Property Inspector):

oe| 8¢ | =l =
[+ Base Properties
[+ Control
= Data
Max
Min
[+ SliderStep

| swing |

TooltipString
Units
Value

# Position

=) Style/Appearance

# BackgroundColor

CData
FontAngle
FontName
FontSize
FontUnits
FontWeight

* ForegroundColor

Style

-
@ Inspector: uicontrol (textl "Static Text")

0]

1.0
0.0
[0,010,1]

|

characters
[0.0]

&
: [0x0 double array]

normal

MS Sans Serif
18.0

points

bold

text

Portiamoci alla voce (String) e digitiamo il
testo desiderato, nel nostro caso:
RISOLUTORE TRAVI CON FEM.

Per modificare le dimensioni e il formato
del testo andiamo nel gruppo
Style/Apparence e modifichiamo i campi
FontSize , FontWeight , FontName.



Realizzazione di un’interfaccia utente con Matlab.

Successivamente inseriamo un oggetto (Panel) che raggruppera gli oggetti relativi
all'inserimento dei dati.

Anche per quest’oggetto & possibile modificare le proprieta attraverso il (Property
Inspector). Nel nostro caso modifichiamo il campo (String) digitando “Dati”.

Andiamo ora ad inserire all'interno del Panel appena creato altri oggetti (Static Text)
modificandone la proprieta (String) fino ad ottenere il seguente risultato.

e T 5
™) C:\Users\kekko\Desktop\file x presentazioe\FILE M X PRESENTAZIONE\D_D_FEM.fig ‘.EM“
File Edit View Layout Tools Help ]
NEd R0 | 2Bhd BH% | b
[ R Select J |
RISOLUTORE TRAVI CON FEM
[ Push Button ] | paTI | |
{ == Slides ] Schema di trave
{ ® Radio Button | . ;
Dimensione trave

[ B4 Check Box J L=
[ I Edit Text } Inerzia sezione
[ 4T Static Text ] = mm~d tl
[ &3 Pop-up Menu ] )

Materiale
{ =l Listbox ] E= NimmA2
[ & Toggle Button ]

MNumero di elementi
[ ETable |

hx = n
[ i{,‘,{ Axes J
{ [%] Panel | Carico distribuito
[ "8 Button Group J q= Nmm
[ =X ActiveX Control ]

]
Current Point: [14, 313] Position: [520, 380, 560, 420]




Realizzazione di un’interfaccia utente con Matlab.

A questo punto occorre inserire al fianco dei testi statici gli (Edit Text) che serviranno
all'inserimento dei dati per la simulazione.

Inseriamo un primo (Edit Text) al fianco della (Static Text) “L =" e gli assegniamo il
valore “0” come (String) e “EDIT_L” come (Tag).

In modo analogo assegniamo agli altri (Edit Text) il valore “0” come (String) e “EDIT _I”,
“EDIT_E”, “EDIT _nx”, “EDIT_qg” come (Tag).

[ 1) C\Users\kekko\Desktop\file x presentaziog\FILE M X PRESENTAZIONE\D_D_FEM fig (=lE] = |
File Edit View Layout Tools Help ‘
NEd s B9 o 2864 5% P E Inspector: uicontrol (EDIT_L "0%) ’EE—% |
h Bz A | Y =4 Nt \
RISOLUTORE TRAVI ¢ |2 24 | 21 =3 1 (Tag) e il nome che verra
. =I Base Properties .
DE| N BeingDeleted associato all’'oggetto per
chema di trave - = . . .
9 i ;|| poterlo richiamare all’interno
= L= o — .
@ Inerzia sezione E:'I:::Fin = ;r;utornatic .; del COdlce' ” nome deve
)| - p s Deteteren ) -/| indicare la variabile
|-o] Materiale HandleVisibility on = y
Err - HiTest = -|| contenuta nell'oggetto. Ad
Interruptible on > .
::rzr;ro di elementin { tlecti:rt\Hihligt on £ esemplo |a nOStra “EDIT_L”
; s atribi ontex‘tMenu iii:;t) i Contlene Ia' Iunghezza
] | P B v st || dell’elemento strutturale.
Visible on o
+ Control
# Data
[# Position
i+ Style/Appearance
Current Point: [0,




Realizzazione di un’interfaccia utente con Matlab.

Procediamo ora con l'inserimento di tre (Push Button) modificandone la (String) in

“Calcola”, “Reset” e “Vai” e il (Tag) rispettivamente in “pushbutton_calcola”,
“pushbutton_reset” e “pushbutton_section”

' | |
¢! D_D_FEM.fig ‘ =1l

File  Edit View Layout Tools Help
NEd smmo o sBBbd D% b
k |

~DATI

Scema di trave

RISOLUTORE TRAVI CON FEM | \

(o]

Sa
xl=By )

=
=

App_App v

Dimensione trave

L= g mm
i Inerzia Sezione Geperica 3
1= o g
Materiale
E= Mimm?*2

Numero di elementi

nx =g n

Carico distribuito

q= Mimm

LCalcola ] [ Reset

< ' S TT— . — »

Tag: figurel Current Point: [2, 415] Position: [520, 304, 867, 496]




Realizzazione di un’interfaccia utente con Matlab.

Passiamo ora all'inserimento del secondo (Panel) e di un oggetto (Axes) per la
visualizzazione dell’output.

FY] CA\Users\kekko\Desktopfile x presentazioe\FILE M X PRESENTAZIONE\D_D_FEM.fig =[=] = |

File Edit View Layout Tools Help

‘le_ﬁd &‘%ﬁ%")(" %Eﬁﬂﬁ II%‘“EP
| RISOLUTORE TRAVI CON FEM
- ~DATI

.. Schema di trave
.. I Dimensione trave

L= 0

H

- Inerzia sezione

I= o mm~d axesi

L
HEEE

| Materiale

los!

MNumero di elementi
nx =pn n

Carico distribuito

[ Calcola ] [ Reset

| Current Point: [193, 404] | Position: [520, 385, 588, 415]




Realizzazione di un’interfaccia utente con Matlab.

Salviamo il progetto ed assegniamogli il nome “D_D FEM” creando quindi il file
“‘D_D FEM.fig”.
Una volta salvato, I'editor di GUI genera automaticamente il file “D_ D _FEM.m”
contenente il codice per gestire l'interfaccia e quindi tutti gli oggetti inseriti fino ad’ora.
Si riporta di seguito uno stralcio del codice generato automaticamente.

~| Editor - C:\Users\kekko\Desktop\file x presentazioe\2 versione\D_D_FEM.m IMI‘
File Edit Text Go Cell Tools Debug Desktop Window Help ¥ 2aX
- DEl | sRRB20 |- Aeh | R-EXBRE B@| s v [0~
B6g | -0 |+ | =11 | x [e%e| @
1 function varargout = D_D FEM(varargin) TD
2
3 % D D FEM M-file for D D FEM.fig
23
24 % Edit the above text to modify the response to help D D FEM
25
286 % Last Modified by GUIDE v2.5 22-Dec-2010 11:45:3¢
27
28 % Begin initialization code - DO NOT EDIT
29 — gui Singleton = 1;
30 — gui_State = struct('gui Name', mfilename, ...
31 "gui_Singleton', gui_Singleton, ...
32 'gui_ OpeningFcn', @D_D FEM OpeningFcn, ...
33 'gui_OutputFecn', @D_D_FEH_Outputhn, 5oE0E
34 'gui_LayoutFcn', [1 %
35 'gui_Callback', EI)ia
36 — if nargin && ischar (varargin{1})
31 = gui_State.gui Callback = strZfunc(varargin{l}):;
38 - end
39
40 — | if naraout B
< 1 3
“[D_D_FEM.m x| plotaglm x| plotmom.m x|
D_D_FEM / pushbutton_calcola... | Ln 89

Col 1 OVR

—— ——




Realizzazione di un’interfaccia utente con Matlab.

Per creare la barra dei menu clicchiamo sul pulsante (Menu Editor) come in figura che
apre la finestra (Menu Editor).

¥ CAUsers\kekko\Desktop\file x presentazioe\FILE M X PRESENTAZIONE\D_D_FEM.fig E=E X

E e e

File Edit Vlew Layout Toals Help

i]dH L A %%&ﬁ\l@“ b
| T

Ell:

[ [
’ ‘ Rl Menu Editor

- foa
.. Schema di trave
.. ' Dimensione trave

L= [0

gMenuEditor
M -—1 1 |X

To add a menu, click here or on Properties

the New Menu button Nothing selected.

| Inerzia sezione on the toolbar

EEEE
mm

T = 0 | mm*d
(] ' ‘
"8 | Materiale '
E= g Nimm*2

Numero di elementi
nx =o N

Carico distribuito

[ Calcola ] [ Reset ]

Menu Bar | Context Menus

ok || Hep




Realizzazione di un’interfaccia utente con Matlab.

Nella finestra (Menu Editor) clicchiamo sul pulsante (New Menu) per inserire un nuovo
menu.

E Menu Editor ﬂ]ﬁ_hj . . .
. = - Poi clicchiamo sul pulsante
et (New Menu Item) per inserire una voce
Nothing selected. dl menu
E Menu Editor M
Hig|le=—-1 1 |X
L___EMEI& ; | Menu Properties
; Uniled 16 Label: |Untitled 12
Tag: |Untitled_12
Accelerator: Ctrl + None A
[7] Separator above this item
[] Check mark this item >
| - : | [¥] Enable this item
Menu Bar | Context Menus|
= o ‘ Callback: %automatic
OK |
More Properties...

Menu Bar Context Menus}

| ok || Hep |

Nominiamo il menu modificando la proprieta (Label) in “File” e quindi assegniamo come
(Tag) il nome “M_File”.



Realizzazione di un’interfaccia utente con Matlab.

Per completare la barra procediamo allo stesso modo per tutti i menu e le voci di menu
ottenendo il seguente risultato.

g Menu Editor == & |
EEE[-—1 X
:, File Menu Properties
e Apri Label: |Visualizza
. e Salva
. Tag: |M_Visuali
Cj}" Analisi ag _Visualizza
: '=‘ Esegui Accelerator: Ctrl + None v
L A Reset . )

= [ Visualizza
. A Deformata
-E4 Momento

L. Errore

—r Esporta

Menu Bar | Context Menus

|| Separator above this item
[] Check mark this item
(V] Enable this item

Callback:

[ More Properties...

)

ok || Help




Realizzazione di un’interfaccia utente con Matlab.

Per poter visualizzare il risultato finale dobbiamo avviare la figura cliccando sulla freccia
verde posta sulla barra degli strumenti dell’editor di GUI.

File Analisi Visualizza 'S ~

RISOLUTORE TRAVI CON FEM

— DATI

Scema di trave
appapp hd

Dimensione trave
L =g mm

Inerzia Sezione Genetica

1= [o vai mma INSERISCI | DATI
~ E
e _— CLICCA SUL PULSANTE
CALCOLA

MNumero di elementi
nx = n

Carico distribuito
q= 0 Nmm

[ Calcola ] [ Reset




Realizzazione di un’interfaccia utente con Matlab.

Per creare la barra degli strumenti clicchiamo sull'icona (Toolbar Editor) nell’editor di
GUI che apre la finestra (Toolbar Editor).

Y] C:\Users\kekko\Desktop\file x presentazioe\2°versione\D_D_FEM.fig

(= E )

File Edit View Layout Tools Help

(1= mm’\4 E

| Materiale

|
Eofs
=a

\

IR L R aagéﬁéﬁg@f*é b

Toolbar Editor

DATI

Scema di trave
App_App v

Dimensione trave
L =1 mm

Inerzia Sezione Generica

E=[g Nimm"2

| Numero di elementi

nx =0 n

Carico distribuito
q =0 Ninm

[ Calcola ] [ Reset

ﬁ Toolbar Editor

Toolbar Layout

Add tools here to create a toolbar. Drag and drop from the palette or press the Add button

— Tool Palette

Custom Tools

P Push Tool

Predefined Tools
D New
Il save
*, Zoom In
4™ pan
‘.E Data Cursor

EI Legend

T Toggle Tool

(=4 Open

2 Print

=, Zoom Out
*®) Rotate

D Colorbar

X
Add Delete f=e ¢= =) =)
Tool Properties| Toolbar Properties
Tagy:

Make toolbar visible

More Property ...

o | [ e




Realizzazione di un’interfaccia utente con Matlab.

Inseriamo all'interno della nostra barra degli strumenti i pulsanti “Apri” e “Salva”
scegliendo le relative icone all'interno di (Tool Palette) - (Predefined Tools) e

cliccando sul pulsante (Add).

r = T Al
4 Toolbar Editor Fases SHRCH X )
Toolbar Layout
-
&l |E3
— Tool Palette : :
Custom Tools i Add % Delete ¢ J [ s ] @ @
P Push Tool T Toggle Tool lTo:)IPrJf‘dd selected palette ,5?.2'.’&? toolbar|
Predefined Tools Cate (lcor: = [ (—T— Modifichiamo le proprieta
i il " e (Tag) scrivendo “TB_apri” e
7 Save 2 Print Toottip String: Open File “TB I " -
salva .
*,, Zoom In =, Zoom Out [¥] Enable this tool -
&M pan *®) Rotate "] Separator on left side
i Data Cursor [ colorbar Clicked Callback %defautt
Legend
[ More Property ... J
[ Restore Defaults ]
‘ OK J ‘ Help



Realizzazione di un’interfaccia utente con Matlab.

Completiamo la barra degli strumenti creando i pulsanti personalizzati: “Esegui”,

“‘Reset”, “Struttura”, “Deformata”, “Momento”, “Taglio”, “Errore” e “Tabelle dati”

I I

scegliendo (Push Tool) all'interno di (Tool Palette) - (Custom Tools) e cliccando sul
pulsante (Add).

% Tooibar it [E=EE) . . e \
L'icona di default [P ¥ puo essere
Toolbar Layout
oolbar Layo s . . .
ey ® modificata a proprio piacimento
ToolPriete : | - - aprendo I'(iconeditor) cliccando sul
Custom Tools ’ dd %! l Belets ] [U E' @ @ I t E d . t
P PushTool T Toggle Tool | Tool p';O‘Add sevlected palette item fo toolbarl —") pu San e ( I )
: S T — iconeditor FEEss liiili_hj
Predefined Tools CData (icon): P [ Ediit ... ’
—j NE ‘j sl Tag: uipushtool10 Import icon file: |Create a new icon below or type in an icon image file for editing Import ...
! (=l save iz Print Toottip String: — Icon Edit Pane (16 X 16) — Preview
*, ZoomIn =, Zoom Out [¥] Enable this tool
4™ pan 5 Rotate Separator on left side @ =]
\.|.:_1 Data Cursor D Colorbar Clicked Callback [ViﬂJ %
[537] Legend W _ Color Palette
= | (NN
AEEEEEEEEEEER EREENENN
| ] | ERNNENNNN
More Property ... il B B TEEErT
L [ [ [ [ [ ]| o7
G0
B:0
OK ] { Help ] i More Colors .. ’
|

oK l ‘ Cancel ] \ Help }




Realizzazione di un’interfaccia utente con Matlab.

Per ogni pulsante personalizzato realizzato precedentemente modifichiamo, all'interno di

(Tool Properties) il (Tag) scrivendo: “TB_struttura”, “TB_deformata”, “TB_momento”,
“TB_taglio”, “TB_errore”, “TB_tabelle”.

24 Toolbar Editor (=] = ]
Toolbar Layout
= o r
S| > X[ ki@ E E IS
— Tool Palette (—‘ ]
Custom Tools [ Add ] { Delete ] k : J E] E] [j]
P Push Tool T Toggle Tool | Tool Properties ]ToolbarPropertiesi
Predefined Tools CData (icon): (&) [ Edit ... ]
Lytets & oo Tag
=l Save ¢2 Print Toottip String: Momento
*,, ZoomIn =, Zoom Out [¥] Enable this tool
&M pan '®) Rotate [7] Separator on left side
Ei'\J. Data Cursor D Colorbar Clicked Callback D_D_FEM('TB_momer| |View
Legend
More Property ...

{ |0K HHap]l




Realizzazione di un’interfaccia utente con Matlab.

Per ogni pulsante inserito all'interno dalla barra degli strumenti occorre generare |l
codice. Cio viene fatto automaticamente dall’editor di GUI cliccando il pulsante (View)
all'interno della (Toolbar Editor).

4 Toolbar Editor o 1S ||
Toolbar Layout
= | s | = —
S > XV i @ E B 163
— Tool Palette
Custom Tools [ Add ] l Deisin I E > [:}‘ : [ZJ [: A ’
P Push Tool T Toggle Tool ! Tool Properties ‘ e e Propertiesﬂi
Predefined Tools CData (icon): = 1 Edit ... ]
) New =] Open Tag: TB_struttura
H Save g :a Print Toottip String: Struttura
*, ZoomIn ={, Zoom Out [¥] Enable this tool
4™ pan B Rotate [V] Separator on left side
4| Data Cursor [ colorbar Clicked Callback
Legend . 4 -
9 Clicked Callback D_D_FEM(TB_struttu | View
I More Property ... ]
[ OK ‘ , Help \
function TB_struttura_ClickedCallback(hObject, eventdata,

handles)

% hObject handle to TB_struttura (see GCBO)

% eventdata reserved - to be defined in a future version of
MATLAB

% handles structure with handles and user data (see
GUIDATA)

calcola(handles)




Elaborazione del codice contenente le istruzioni da

eseguire dopo 'immissione dei dati



Elaborazione del codice contenente le istruzioni da eseqguire
dopo I'immissione dei dati

Dopo aver completato I'inserimento degli oggetti grafici dobbiamo scrivere il codice
necessario sia alla gestione degli stessi, sia alla gestione delle funzioni esterne.

Come gia detto precedentemente I'editor di GUI genera in automatico il file D D FEM.m
associato alla nostra interfaccia. Le prime 44 righe di questo file non vanno modificate
perché servono a stampare a video la finestra principale. Mentre nelle righe successive
sono riportate tutte le funzioni associate agli oggetti grafici.

Per inizializzare la finestra principale prima che questa venga visualizzata viene creata
la funzione D D FEM OpeningFcn.

Per ogni oggetto Edit text troviamo una funzione Createfcn (create function) che
inizializza 'oggetto e una funzione Callback (funzione risposta) che viene richiamata
quando si modifica il contenuto dell’oggetto stesso.

Per gli oggetti push button, per i menu, per le voci di menu e per i pulsanti della barra
degli strumenti troviamo la funzione Callback (funzione risposta) che viene richiamata

guando clicchiamo su di essi.



Elaborazione del codice contenente le istruzioni da eseqguire

dopo I'immissione dei dati

Come primo passo scriviamo la funzione initialize gui che e formata dal

seguente blocco di istruzioni:

function initialize_gui(handles)

%creo la struttura (dati) che conterra i dati del problema.
handles.dati.L=0;
handles.dati.E=0;
handles.dati.l=0;
handles.dati.nx=0;
handles.dati.q=0;
handles.dati.strutt=1;

%fattore di scala per i diagrammi
handles.dati.su=10;
handles.dati.sm=0.000005;
handles.dati.sv=0.001;
handles.dati.funz=[];

%creo la struttura (vettori) che conterra i vettori
Y%restituiti dalle funzioni risolutrici
handles.vettori.x=[];
handles.vettori.u=[];
handles.vettori.U=][];
handles.vettori.v=[];
handles.vettori.V=[];
handles.vettori.mo=[];
handles.vettori.Mo=[];
handles.vettori.Er=[];
handles.vettori.vinc1x=[];

handles.vettori.vincly=[];
handles.vettori.vinc2x=[];
handles.vettori.vinc2y=[];
handles.vettori.strx=[J;
handles.vettori.stry=[];

%salvo le strutture appena create (dati e vettori)
%nella struttura principale handles
guidata(handles.figurel,handles);

%passiamo i dati alle edit_text
set(handles.popup_schematrave,'Value',1);
set(handles.EDIT_L,'String',handles.dati.L);
set(handles.EDIT_E,'String',handles.dati.E);
set(handles.EDIT _I,'String',handles.dati.l);
set(handles. TEX_sezione,'String','Sezione Generica’);
set(handles.EDIT _nx,'String',handles.dati.nx);
set(handles.EDIT_g,'String',handles.dati.q);

%nascondo axes
set(handles.axesl,'Visible','off");
%visualizzo avviso

set(handles. TEXT_AVVISO,'Visible','on’);
%blocco menu esporta
set(handles.M_Esporta,'Enable’, 'off")
cla;

Con tale funzione vengono create le strutture (dati e vettori) che contengono dati
condivisi tra varie funzioni. Vengono inoltre settati i valori iniziali da visualizzare nelle

Edit Text.




Elaborazione del codice contenente le istruzioni da eseqguire
dopo I'immissione dei dati
La funzione initialize gui sara richiamata quando viene inizializzata la finestra

principale, quando clicchiamo sul pulsante Reset, quando clicchiamo Analisi->Reset
dalla barra dei menu e quando clicchiamo il pulsante Reset dalla barra degli strumenti.

Purche questo avvenga occorre richiamare la funzione initialize gui all'interno

delle rispettive funzioni Callback come riportato di seguito:

function D_D_FEM_OpeningFcn(hObject, eventdata, handles, varargin)
% This function has no output args, see OutputFcn.

% hObject handle to figure

% eventdata reserved - to be defined in a future version of MATLAB

% handles structure with handles and user data (see GUIDATA)

% varargin command line arguments to D_D_FEM (see VARARGIN)
% Choose default command line output for D_D_FEM

handles.output = hObject;

% Update handles structure

guidata(hObject, handles);

initialize _gui(handles);

function pushbutton_reset_Callback(hObject, eventdata, handles)

% hObject handle to pushbutton_reset (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)
%resetto la finestra avviando la funzione initialize_gui

initialize _gui(handles)

function TB_reset_ClickedCallback(hObject, eventdata, handles)

% hObject handle to TB_reset (see GCBO)
% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

initialize_gui(handles)

function M_Reset_Callback(hObiject, eventdata, handles)

% hObject handle to M_Reset (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

initialize_gui(handles)
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Procediamo ora con la scrittura della funzione calcola che esegue le seguenti azioni:

» salva nella struttura “handles.dati” ivalori numerici inseriti nelle Edit Text e
la tipologia di struttura scelta attraverso il Popup Menu;

= esegue un controllo per verificare la compatibilita dei dati inseriti;

» richiama, attraverso il costrutto swich, la funzione adatta a risolvere il tipo di
struttura selezionato nel Popup Menu;

» salva nella struttura handles.matrici i seguenti vettori (x',u,v,mo) restituiti
dalla funzione risolutrice al fine di poterli visualizzare ed esportare in altri formati (ad
esempio .xIs);

= attiva il Menu Esporta inizialmente disabilitato.



Elaborazione del codice contenente le istruzioni da eseqguire
dopo I'immissione dei dati

La funzione calcola e formata dal seguente blocco di istruzioni:

function calcola(handles) case 2
[handles]=incapp(handles);

%salvo i dati inseriti nelle edit_text nella struttura (dati) case 3
handles.dati.L = str2double(get(handles.EDIT_L,'String")); [handles]=incinc(handles);
handles.dati.E = str2double(get(handles.EDIT_E,'String")); case 4
handles.dati.l = str2double(get(handles.EDIT _I,'String")); [handles]=inclib(handles);
handles.dati.nx = str2double(get(handles.EDIT_nx,'String")); otherwise
handles.dati.q = str2double(get(handles.EDIT_q,'String")); [handles]=appapp(handles);
handles.dati.strutt = get(handles.popup_schematrave,'Value'); end
%se L=0 la funzione si arresta %salvo i vettori restituiti dalla funzione nella struttura (vettori)
if handles.dati.L==0 x = handles.vettori.x;

return u = handles.vettori.u;
end v = handles.vettori.v;

mo = handles.vettori.mo;
%visualizzo I'oggetto axesl

set(handles.axesl,'Visible','on’); %creo la struttura (matrici)nella quale salvo la matrice Mdati che ha per
%colonne i vettori (X' u mo v) necessaria per il iempimento e il salvataggio
%nascondo la static_text %dei dati numerici
set(handles. TEXT_AVVISO,'Visible','off"); handles.matrici.Mdati=[x',u,mo,V];
%avvio la funzione "appapp", "incapp"”,"incinc" o"inclib" %salvo la struttura (matrici) appena creata
%in base alla selezione fatta dal popupmenu guidata(handles.figurel,handles);
switch handles.dati.strutt %attivo il menu esporta
case 1 set(handles.M_Esporta,'Enable’, ‘on’)

[handles]=appapp(handles);
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E sara richiamata quando clicchiamo i pulsanti Calcola, Analisi->Esegui dal menu,
Esegui dalla barra degli strumenti e quando selezioniamo lo schema di trave dal
popupmenu.

Si riportano di seguito i blocchi di codice relativi alle funzioni Callback degli oggetti sopra
elencati:

function pushbutton_calcola_Callback(hObject, eventdata, handles)
% hObject handle to pushbutton_calcola (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)
%richiamo la funzione calcola

calcola(handles)

function M_Esegui_Callback(hObject, eventdata, handles)

% hObject handle to M_Esegui (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)
calcola(handles)

function TB_esegui_ClickedCallback(hObject, eventdata, handles)
% hObject handle to TB_esegui (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)
calcola(handles)

function popup_schematrave Callback(hObject, eventdata, handles)
% hObject handle to popup_schematrave (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

calcola(handles)




Elaborazione del codice contenente le istruzioni da eseqguire
dopo I'immissione dei dati

Per il nostro progetto sono state compilate le seguenti funzioni risolutrici:

1. appapp.m perlo schema di trave appoggio-appoggio;
2. incapp.m per lo schema di trave incastro-appoggio;

3. incinc.m per lo schema di trave incastro-incastro;

4. inclib.m perlo schema di trave incastro-estremo libero.

Esaminiamo ora il listato della funzione appapp.m:

function [handles]=appapp(handles)
% DATI
L = handles.dati.L; %lunghezza della trave

E = handles.dati.E;  %modulo elastico del materiale
| = handles.dati.l; %inerzia della sezione scelta
nx = handles.dati.nx; %numero di elementi finiti

g = handles.dati.q;  %carico distribuito

I=L;

El=E*I;

h=I/nx; %Ilunghezza elemento

m=nx*2; %Dimensione matrice K:m identifica il numero di righe
n=nx*2;  %Dimensione matrice K:n identifica il numero di colonne

x=linspace(0,l,nx+1);
k=Getk(El,h); %matrice di rigidezza del singolo elemento finito

%Si puo quindi definire la matrice di rigidezza K dell'intera trave
%suddividendola in alcune sottomatrici

A=k(2:2,2:2);

B=k(2:2,3:4);

C=k(1:2,4:4);

D=k(4:4,4:4);

M=k(1:2,3:4);

L=(k(1:2,1:2)+k(3:4,3:4));
Qfpm-mmmmmmmm e MATRICE DI RIGIDEZZA GLOBALE
K=zeros(m,n);
K(1:1,1:1)=[A];
K(1:1,2:3)=[B]J;
K(2:3,1:1)=[BT;
K((m-2):(m-1),n:n)=[C];
K(m:m,(n-2):(n-1))=[C;
K(m:m,n:n)=[D];
if Nx>=3
K(2:3,2:5)=[L M];
K((m-2):(m-1),(n-4):(n-1))=[M" L];

z=4;y=2;
for i=1:nx-3
K(z:(z+1),(y:y+5))=[M' L M];
z=7+2;
y=y+2;
end
else
K(2:3,2:3)=[L];
end
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Op=-=-=mmmmmem Si definisce il vettore dei carichi
fd=zeros(m,1);
fd(1)=-g*h"2/12;
fd(m)=qg*h"2/12;
fd(m-1)=0;
z=2;
for i=1:nx-1
fd(z:z+1)=[-g*h O];
z=7+2;
end
% FEM
us=K\fd; %coefficienti approssimati

xc=zeros(nx+1,1); %vettore colonna delle coordinate dei vari elementi
xc(1)=0;
xc(nx+1)=l;
=2;
for i=1:nx-1
xc(j,1)=i*h;
=ity
end

%Valori dei coefficienti hermitiani per il primo elemento[0,h]
N21=xc(1:2)-2*xc(1:2)."2/h+xc(1:2)."3/h"2;
N31=3*xc(1:2)./2/h"2-2*xc(1:2)."3/h"3;
N41=-xc(1:2).22/h+xc(1:2).73/h"2;

%Valori dei coefficienti hermitiani per I'i-esimo elemento
N1=1-3*(xc(nx:nx+1)-xc(nx)). 2/h"2+2*(xc(nx:nx+1)-xc(nx)).A3/h"3;
N2=(xc(nx:nx+1)-xc(nx))-2*(xc(nx:nx+1)-xc(nx)).~2/h+(xc(nx:nx+1)-
xc(nx)).~3/h"2;

N3=3*xc(1:2).22/h"2-2*xc(1:2).”3/h"3;
N4=-(xc(nx:nx+1)-xc(nx)).A2/h+(xc(nx:nx+1)-xc(nx)).*3/h"2;

%Valori dei coefficienti hermitiani per I'ultimo elemento[nx,nx+1]
N1=1-3*(xc(nx:nx+1)-xc(nx)). 2/h"2+2*(xc(nx:nx+1)-xc(nx)).A3/h"3;
N2=(xc(nx:nx+1)-xc(nx))-2*(xc(nx:nx+1)-xc(nx)). 2/h+(xc(nx:nx+1)-

xc(nx)).~3/h"2;
N4=-(xc(nx:nx+1)-xc(nx)).A2/h+(xc(nx:nx+1)-xc(nx)).~3/h"2;
% Deformata approssimata
u=zeros(nx+1,1);
%valore dello spostamento nell'estremo iniziale
u(1:2,1)=N21*us(1)+N31*us(2)+N41*us(3);
%valore dello spostamento nell'estremo finale
u(nx:nx+1,1)=N1*us(m-2)+N2*us(m-1)+N4*us(m);
j=2;p=2;
for i=1:nx-2
u(j:j+1,1)=N1*us(p)+N2*us(p+1)+N3*us(p+2)+N4*us(p+3);
=i+

U=-g*(x'."4-2**x".3+I"3*x")/24/EI; %deformata esatta di una trave app-app p=p+2;

end

Er=U-u;

% REAZIONI
F1=k(1,2)*us(1)+k(1,3)*us(2)+k(1,4)*us(3)+g*h/2;
F2=k(3,1)*us(m-2)+k(3,2)*us(m-1)+k(3,4)*us(m)+qg*h/2;
% TAGLIO
V=q*I/2-(g*x"); %Taglio esatto di una trave app-app
v=zeros(nx+1,1);

V(1)=F1; %valore del taglio approssimato nel primo estremo
v(nx+1)=-F2; %valore del taglio approssimato nell'ultimo estremo
if Nx>3

%valore del taglio approssimato nel primo nodo interno,calcolato come
Y%appartente al primo elemento
v(2)=(k(1,1)*us(2)+k(1,2)*us(3)+k(1,3)*us(4)+k(1,4)*us(5))+q*h/2;

else
v(2)=(k(1,1)*us(2)+k(1,2)*us(3)+k(1,4)*us(4))+g*h/2;

end

=3;p=2;

for i=1:nx-2
V(j)=-(k(3,1)*us(p)+k(3,2)*us(p+1)+k(3,3)*us(p+2)+k(3,4)*us(p+3))-g*h/2;
=+
p=p+2;

end
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% MOMENTO
Mo=(g*I/2)*x-((g*(x").*2)/2); %Momento esatto di una trave app-app %o------=-mmmmmmm oo PLOTTAGGIO DELLE REAZIONI VINCOLARI----------------
mo=zeros(nx+1,1); %Momento approssimato ff1=num2str(F1);
mo(1)=0; %momento approssimato nel primo estremo ff2=num2str(F2);
mo(nx+1)=0; %momento approssimato nell'ultimo estremo  text(0,-14*s,['R1=",ff1," N'],'HorizontalAlignment','left','FontSize',10);
text((L-20*s),-14*s,['R2=",ff2," N'],'HorizontalAlignment','left’,...
if Nnx>=3 'FontSize',10);
%momento approssimato nel primo nodo interno %----salvo i vettori restituiti dalla funzione nella struttura (vettori)
mo(2)=-(k(2,1)*us(2)+k(2,2)*us(3)+k(2,3)*us(4)+k(2,4)*us(5))-g*h"2/12; handles.vettori.x=x;
else handles.vettori.u=u;
mo(2)=-(k(2,1)*us(2)+k(2,2)*us(3)+k(2,4)*us(4))-q*h"2/12; handles.vettori.U=U;
end handles.vettori.v=v;
handles.vettori.V=V;
j=3;p=2; handles.vettori.mo=mo;
for i=1:nx-2 handles.vettori.Mo=Mo;
%valore del momento per tutti i nodi interni handles.vettori.Er=Er;
mo(j)=(k(4,1)*us(p)+k(4,2)*us(p+1)+k(4,3)*us(p+2)+k(4,4)*us(p+3))- handles.vettori.vinc1x=vinclx;
g*hn2/12; handles.vettori.vincly=vincly;
=i+, handles.vettori.vinc2x=vinc2x;
p=p+2; handles.vettori.vinc2y=vinc2y;
end handles.vettori.strx=strx;
% DISEGNO DELLA STRUTTURA handles.vettori.stry=stry;
L=l; % subfunction
s=L/100; %----definizione della matrice di rigidezza del singolo elemento finito
vinc1x=[0,-3,-5,-5,5,5,-3,3,0].*s; function k=Getk(El,h)
vincly=[O0, -7, -7,-10,-10, -7, -7, -7,0].*s; k(1,1)=12; k(1,2)=6*h; k(1,3)=-12; Kk(1,4)=6*h;
strx=[0,L]; k(2,1)=6*h; k(2,2)=4*h"2; k(2,3)=-6*h; k(2,4)=2*h"2;
stry=[0,0]; k(3,1)=-12; k(3,2)=-6*h; k(3,3)=12;  k(3,4)=-6*h;
carx1=[L,L,L,L,L,L,L,L,L]; k(4,1)=6*h; k(4,2)=2*"2; k(4,3)=-6*h; k(4,4)=4*h"2;
carx2=[0,-3,-5,-5,5,5,-3,3,0].*s; k=EI/h"3*k;
vinc2x=carxl+carx2;
vinc2y=[0, -7, -7,-10,-10, -7, -7, -7,0].*s;
Qo---------m-m - PLOTTAGGIO DELLA STRUTTURA
plot(vinclx,vincly, 'k',vinc2x,vinc2y,'k',strx,stry,'b’,'LineWidth’,2);
axis([-10*s L+10*s -L/2 L/2]);
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Scegliendo quindi dal popupmenu lo schema di trave App-App e lanciando la soluzione
cliccando sul pulsante calcola, si otterra il seguente risultato:

File Analisi Visualizza | Esporta

Sl > X hr®WE B

RISOLUTORE TRAVI CON FEM
— DATI
Scema di trave
APD_ADD v. 3000 I 1 1 I I 1 I
Dimensione trave
L= 's000 mm 2000 —
Inerzia Sezione Generica 1000 i

I= |301e+007 mmAg

Materiale 0F
E= 210000 Nimm?*2 l'él é

1000 - R1=300000.0002 N R2=300000.0001 N |
MNumero di elementi
nx = 100 n

-2000 - il
Carico distribuito
9= |100 Nimm -3000 !

| | | | | |
0 1000 2000 3000 4000 5000 6000

Calcola ] [ Reset ]
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Dopo aver risolto la struttura con la funzione vista precedentemente dobbiamo creare le
funzioni necessarie alla visualizzazione dei diagrammi delle sollecitazioni e della
deformata.
Sono state scritte le seguenti funzioni:
» Plotdef.m per il plottaggio della deformata,;
« Plotmom.m per il plottaggio della funzione momento;
« Plottagl.m per il plottaggio della funzione taglio;
* Ploterr.m per il plottaggio dell’errore tra la funzione spostamento esatta e quella
approssimata.

Siriporta il listato della funzione plotdef.m:

function plotdef(handles)

% DATI Qfp-----mmmm e PLOTTAGGIO DELLA DEFORMATA------------
x=handles.vettori.x; plot(x,u.*su,'g',x,U.*su,'m*:" vinclx,vincly,'k',vinc2x,vinc2y,'k',strx,stry,'b");
u=handles.vettori.u; %settaggi del plot

U=handles.vettori.U; s=L/100;

L=handles.dati.L; axis([-10*s L+10*s -L/2 L/2]);

su=handles.dati.su; lab=linspace(-L/2,L/2,9)/su;

vinclx=handles.vettori.vinclx; labl=linspace(-L/2,L/2,9);

vincly=handles.vettori.vincly; set(handles.axesl,'YTickLabel'lab");
vinc2x=handles.vettori.vinc2x; set(handles.axes1,'YTick',labl");
vinc2y=handles.vettori.vinc2y; xlabel(’x [mm]);

strx=handles.vettori.strx; ylabel('U [mm]");

stry=handles.vettori.stry; title('Deformata’);

%elimina il precedente plottaggio legend('FEM','Exact',0);

axes(handles.axesl)

cla
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Come si nota alla funzione plotdef (handles) viene passata la struttura handles
nella quale sono state salvate le strutture (dati e vettori) contenenti i valori necessari al
plottaggio della funzione spostamento.

In modo analogo sono state scritte le altre funzioni.

Ora non ci resta che associare ai pulsanti Deformata, Momento, Taglio ed Errore
presenti nella barra degli strumenti e alle voci di menu visualizza le relative funzioni.

Siriporta il listato per la sola funzione plotdef:

function TB_deformata_ClickedCallback(hObject, eventdata, handles)
% hObject handle to TB_deformata (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

%richiamo la funzioe esterna (plotdef) e plotto la deformata della struttura

plotdef(handles);

function M_Deformata_Callback(hObject, eventdata, handles)

% hObject handle to M_Deformata (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

%richiamo la funzioe esterna (plotdef) e plotto la deformata della struttura
plotdef(handles);
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Cliccando sul pulsante Deformata, ad esempio, per la trave vista precedentemente si
ottiene il seguente risultato:

(B 0.0 Fem EEIES
File Analisi Visualizza | Esporta
SE| > X|~~&®MWE B
RISOLUTORE TRAVI CON FEM
—DATI
Scema di trave Deformata
ADP_APP v. 300 1 I 1 1 I I 1
: : ’ FEM
Dimensione trave 225 ---¥-- Exact| T
L = ls000 iy
150 -
Inerzia Sezione Generica
I= 801e+007 | [vaijmm 5r i
E
Materiale E — 2
E= 210000 Ninm2 = -
751 A -
Mumero di elementi
-150 —
nx =100 n
Carico distribuito 22 ]
q9= 100 Nimm 300 L ] ] L L ] L
0 1000 2000 3000 4000 5000 6000
X [mm]

[ Calcola ] [ Reset

|
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Per visualizzare la tabella dati clicchiamo sul pulsante Tabella della barra degli

strumenti che apre la seguente figura:

[ B TABELLA DATI = [@] & ]
DATI NUMERICI
X u m Vv

1 0 0 0 2.7500e+05 -
2 55 22662 14974e+07  2.6950e+05 1
3 110 45297 29645e+07  2.6400e+05 3
3 165 67879  4.4014e+07  2.5850e+05 |
5 220 90382 58080e+07  2.5300e+05

é 275 112781 71844e+07  2.4750e+05

7 330  -135050 B85305e+07  2.4200e+05

8 385 157166 0.8464e+07  2.3650e+05

a 440 179105 11132e+08  2.3100e+05

10 495 200844 12387e+08  22550e+05

11 550  -222360 13613e+08  2.2000e+05

12 605  -243631 14807e+08 21450e+05

13 660  -26.4636 15972e+08  2.0900e+05

14 715 -285354 17106e+08  2.0350e+05

15 770  -305765 1.8211e+08 1.9800e+05

16 825  -325848 19284e+08  1.9250e+05 AP

Fsporta Excel] | Esporta Txt] [ Chiudi ]
.
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dopo I'immissione dei dati

La figura vista prima € stata realizzata senza l'ausilio dell’editor di GUI scrivendo

manualmente la funzione tabella_dati.m.

Come si puo vedere la figura presenta il pulsante Chiudi che chiude questa finestra e ci

riporta sulla finestra principale, ed i pulsanti Esporta Txt ed Esporta Excel che
permettono I'esportazione dei dati nei rispettivi formati.
Si riporta di sequito il listato della funzione tabella _dati.m:

function tabella_dati(handles)

%come si puo vedere alla funzione deve essere passato il valore

% (handles)che contiene le indicazioni sulla struttura della figura

%principale per poter riconosce gli oggetti contenuti in essa.

Mdati = handles.matrici.Mdati;

% __INIZIALIZZAZIONE DEGLI OGGETTI GRAFICI___

% FIGURA PRINCIPALE

form1=figure('Position’,[400,300,600,400],'Name'," TABELLA DATI',...

‘NumberTitle','off','Color',[0.941 0.941 0.941],...
'Resize','off','WindowStyle','modal’);
% STATIC TEXT
testo = uicontrol(form1,'Style','text','Position',[250,370,100,25]....
'String','DATI NUMERICI";

% TABLE

cnames = {x','u’,)'m','v'};

table = uitable('Data’,Mdati,'ColumnName',cnames,...

'Parent’,form1,'Position’,[10 50 580 320]);

% PULSANTI

Esporta_Excel = uicontrol(form1,'Style','pushbutton’,...
'Position’,[20,10,70,25],'String','Esporta Excel',...
'‘Callback’,@esporta_excel_plot);

Esporta_Txt = uicontrol(form1,'Style','pushbutton’,...
'Position’,[110,10,70,25],...
'String','Esporta Txt','Callback’,@esporta_txt_plot);

chiudi = uicontrol(form1,'Style','pushbutton’,'Position’,[200,10,70,25],...
'String','Chiudi','Callback’,@chiudi_plot);
% FUNZIONE PULSANTE ESPORTA EXCEL
function esporta_excel_plot(hObject,eventdata)
[file,path] = uiputfile(‘animinit.xIs','Save file nhame');
if file==0
return
end
pathfile=joinseq(path,file);
xlswrite(pathfile, Mdati);
end
% FUNZIONE PULSANTE ESPORTA TXT
function esporta_txt_plot(hObject,eventdata)
[file,path] = uiputfile(‘animinit.txt','Save file name');
if file==0
return
end
pathfile=joinseq(path,file);
dimwrite(pathfile, Mdati);

end
% FUNZIONE PULSANTE CHIUDI
function chiudi_plot(hObject,eventdata)
close
end

end




Elaborazione del codice contenente le istruzioni da eseqguire
dopo I'immissione dei dati

L'esportazione dei dati nei formati .xIs e .txt pud essere eseguita anche dal menu
Esporta assegnando i seguenti blocchi di istruzioni alle funzioni Callback delle rispettive
voci di menu Excel e Text.

Si riporta di sequito il listato delle due funzioni:

Esportazione Excel: Esportazione Text:
function M_Excel_Callback(hObject, eventdata, handles) function M_Text_Callback(hObject, eventdata, handles)
% hObject handle to M_Excel (see GCBO) % hObject handle to M_Text (see GCBO)
% eventdata reserved - to be defined in a future version of MATLAB % eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA) % handles structure with handles and user data (see GUIDATA)
%esporto i dati in un file excel %esporto i dati in un file di testo txt
[file,path] = uiputfile(‘animinit.xIs','Save file hame’); [file,path] = uiputfile(‘animinit.txt','Save file name);
if file==0 if file==0
return return
end end
pathfile=joinseq(path,file); pathfile=joinseq(path,file);
xIswrite(pathfile, handles.matrici.Mdati); dimwrite(pathfile, handles.matrici.Mdati);




Elaborazione del codice contenente le istruzioni da eseqguire
dopo 'immissione dei dati

Vediamo ora la funzione che é stata assegnata al pulsante vai.
Cliccando su di esso si apre la seguente figura:

(B 0.0_FeMm . -

File Analisi Visualizza | Esporta
Sl b X| =@~ E B

,
SELEZIONA | tan S

SEZIONI:
| —DATI :
IPE0 -
! [IPE100
Scema di trave !lPE120
‘IPEMO
App_App v |IPE160
[IPE180 -

Dimensione trave

IPE200
|IPE220
IIPE240
IPE270

IPE300

Inerzia Sezione Gene
1= |

Materiale
E= N

[IPE330
IIPE360
IPE400 -]

| oK } [ Annulia

Numero di elementi

nx =g n

La finestra presenta una listbox contenente
diversi tipi di sezioni ed i pulsanti OK ed
Annulla

Cliccando sul pulsante OK si assegna alla edit
text Edit_1 il valore dell'inerzia della sezione
selezionata all'interno della listbox e si chiude
la finestra.

Anche questa figura e stata realizzata senza
I"ausilio dell’editor di GUI scrivendo
manualmente la funzione sezioni.m.

Al pulsante Vai sara quindi associata la
funzione sezioni.m come di seguito riportato:

function pushbutton_section_Callback(hObject, eventdata, handles)
% hObject handle to pushbutton_section (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

%
%richiamo il file.m che contiene I'elenco delle sezioni
sezioni(handles);




Elaborazione del codice contenente le istruzioni da eseqguire

dopo I'immissione dei dati

Vediamo ora il listato della funzione sezioni.m:

function sezioni(handles)

%come si puo vedere alla funzione deve essere passato il valore
%(handles)che contiene le indicazioni sulla struttura della figura
%principale per poter riconosce gli oggetti contenuti in essa.

%

%carico la lista delle sezioni da un file di testo .txt creato
%precedentemente

[Vsezl,Vsez2 | = textread('SEZ.txt','%s %s' );

%

%definizione della figura che contine gli oggetti
form1=figure(...

'Position’,[600,300,200,280]....

‘Name','SELEZIONA',...

‘NumberTitle','off',...

'Color',[0.941 0.941 0.941],...

'Resize’,'off',...

‘WindowsStyle','modal’);

%STATIC TEXT

ST_TEXT = uicontrol(form1,'Style','text',...
'Position’,[10,250,180,25],...
'String’,'SEZIONI:");

%LIST BOX

lista_sez = uicontrol(form1,'Style','listbox’, ...
'Position’,[10 50 180 200],...
'‘Backgroundcolor',[1.0 1.0 1.0],...
'String',Vsez1);

%PULSANTI

B_ok = uicontrol(form1,'Style','pushbutton’,...
'Position’,[20,10,70,25],...
'String','OK,...
‘Callback’,@OK_plot);

B_annulla = uicontrol(form1,'Style','pushbutton’,...
'Position',[110,10,70,25],...
'String','Annulla’,...
‘Callback’,@annulla_plot);

%

function OK_plot(hObject,eventdata)

%otteniamo la posizione dell'elemento selezionato
sez=get(lista_sez,'Value');

%assegniamo alla cella della figura principale EDIT_I il valore

%numerico corrispondente.

%come si puo vedere é stato richiamato I'oggetto handles
set(handles. TEX_sezione,'String',Vsezl(sez));
set(handles.EDIT_I,'String',Vsez2(sez));
close

end

function annulla_plot(hObject,eventdata)
close
end

end




Elaborazione del codice contenente le istruzioni da eseqguire
dopo 'immissione dei dati

Cliccando sul pulsante Salva, presente nella barra degli strumenti, € possibile salvare i
dati inseriti dall’'utente in un file .txt grazie alla seguente finestra.:

Salva come:

| "bx)

_v_l Annulla ’

-
Save file name IL
Salvain: | J, PROGETTO DE_FUSCO DE_MARTINO  +| ck BB~
= Nome. Ultima ... ¥ | Tipo Dimensione
Py :
{ - ) Untitledl
Risorse recenti f
. esempio2.txt
! L SEZ.bt
Desktop
ik
kekko
Computer
[ Wi
-
Rete
Nome file: [animinit b __v_| Salva

I‘

A

Nella quale possiamo
nominare il file e salvarlo nella
directory desiderata.

Tale finestra viene attivata
tramite la funzione
[file,path] =
uiputfile('animinit.tx
t','Save file name?l).



Elaborazione del codice contenente le istruzioni da eseqguire
dopo I'immissione dei dati

Siriporta il listato della funzione salva:

function salva(handles)

%salvataggio dei valori

Vdati=[handles.dati.L;...
handles.dati.E;...
handles.dati.l;...
handles.dati.nx;...
handles.dati.q;...
handles.dati.su;...
handles.dati.sm;...
handles.dati.sv;...
handles.dati.strutt];

%apro la classica finestra di windows (salva file)per ottenere la stringa
% (file=nomefile.txt e path=percorso completo)
[file,path] = uiputfile('animinit.txt','Save file name");

%se la finestra viene chiusa si blocca la funzione
if file==

return
end

%ottengo il percorso completo piti nome con la funzione joinseq
pathfile=joinseq(path,file);

%scrivo il vettore colonna (Vdati) nel file.txt delimitato con (dimwrite)
dimwrite(pathfile, Vdati);




Elaborazione del codice contenente le istruzioni da eseqguire
dopo 'immissione dei dati

Cliccando sul pulsante Apri, presente nella barra degli strumenti, € possibile aprire file
precedentemente salvati grazie alla seguente finestra:

u Seleziona file I X
Cercain: | J) PROGETTO DE_FUSCO DE_MARTING  v| ¢ &1 £ B3+
o Nome, Ultima mo... Tipo Dimensione
v P
) " ) Untitledl
Risorse recenti :
| esempio2.txt
B s
Desktop
T g
’ {2
kekko
A
Computer
AL
-
Rete
Nome file: lesempioZbd Ll Apri |
Tipo file: I (*bd) _v_l Annulla l

| &

Nella quale possiamo
selezionare |l file.txt ed aprirlo.

Tale finestra viene attivata

tramite la funzione
[FileName, PathName] =

uigetfile('*.txt', 'Sel
eziona file').



Elaborazione del codice contenente le istruzioni da eseqguire
dopo I'immissione dei dati

Si riporta di sequito il listato della funzione Apri :

function apri(handles)

%apro la classica finestra (apri file) e ottengo la due stringhe contenenti
%il nome del file e il percorso completo
[FileName,PathName] = uigetfile("*.txt','Seleziona file");

%unisco le due stringhe in un unica stringa con il comando join
pathfile=joinseq(PathName,FileName);

%copio i dati scritti nel file nella variabile (inVdati)
inVdati = dimread(pathfile);

%assegno i valori letti dal file alle corrispondenti variabili interne
handles.dati.L=inVdati(1,1);
handles.dati.E=inVdati(2,1);
handles.dati.I=inVdati(3,1);
handles.dati.nx=inVdati(4,1);
handles.dati.q=inVdati(5,1);
%fattore di scala per i diagrammi
handles.dati.su=inVdati(6,1);
handles.dati.sm=inVdati(7,1);
handles.dati.sv=inVdati(8,1);
handles.dati.strutt=inVdati(9,1);

guidata(handles.figurel,handles);

%assegno alle edit_text il valore caricato
set(handles.popup_schematrave,'Value',handles.dati.strutt);
set(handles.EDIT_L,'String',handles.dati.L);
set(handles.EDIT_E,'String',handles.dati.E);
set(handles.EDIT_I,'String',handles.dati.l);
set(handles.EDIT_nx,'String',handles.dati.nx);
set(handles.EDIT_g,'String’,handles.dati.q);




Compilazione del file D_D _FEM.m
per ottenere Il file
D D FEM.exe



Compilazione del file D_D_FEM.m per ottenere il file D_ D _FEM.exe

Dopo aver completato la struttura del del programma la cosa che piu ci interessa e
guella di poter distribuire il nostro progetto a utenti che non hanno il programma
Matlab installato sul proprio computer.

Per realizzare il file eseguibile (.exe) da Matlab clicchiamo il pulsante (Start ->
MATLAB -> MATLAB Compiler -> Deployment Tool ). Si avvia in questo modo la
seguente finestra:

4\ MATLAB 7.6.0 (R200 s ;-

SEIFLY EXICY- EIOIE , ue |

il > Command Window BRI, TN T TR
Dl TRx B aw|?

Welcome to the Deployment Tool

Current Director

To get started, do any of the following:

@ Click the New Deployment Project icon O in the Deployment Tool toolbar.
@ Click the Open Deployment Project icon & to open an existing project.
@ Click the Help icon 2 in the toolbar

Use the Deployment Tool to perform these tasks:

Create a

Build
project

Add files

Package

h 4
v
v

Ready



Compilazione del file D_D_FEM.m per ottenere il file D_ D _FEM.exe

Dalla barra dei menu clicchiamo (File -> New Deployment Project ). Si aprira la
seguente finestra.

e’ Nella finestra a destra selezioniamo
MATLAB Compiler A ; . .
MATLAB Builder EX ’ I j Standalone Application ﬁ (W| ndOWS Standalone App“Cat|On)

MATLAB Builder NE
MATLAE Builder JA

>

Digitiamo il nome del nostro progetto

‘ 2 T nella cella (Name) e selezioniamo il
: percorso di salvataggio cliccando sul
=l || »2 C++ Shared Library pU|Sante (Browse...) .

Per terminare la procedura clicchiamo
sul pulsante (OK) che chiude questa
finestra e ci riporta sull'area di lavoro
(Deployment Tool) che si presenta

- [« j » come segue:

Name Untitledl.prj

Location |C}\

[ oK ] [ Cancel ] [ Help ]




Compilazione del file D_D_FEM.m per ottenere il file D_ D _FEM.exe

DS |s@20¢ (AR |0|c v | & |
| = Command Window DeploymentTool o
thwlE M0Ox | Blae|?
é 1. D_F_FEM.prj (Windows Standalone Application)
§ ~~~~~ {_1 Main function
3| (2 Otherfiles
1 5@ crC++files

Generate Verbose Output

4 Startl Ready

Come si puo notare Matlab ha predisposto diverse cartelle che conterranno i file
necessari per la realizzazione dell’eseguibile.




Compilazione del file D_D_FEM.m per ottenere il file D_ D _FEM.exe

Selezioniamo la cartella (Main function) e dal menu clicchiamo su (Project ->
Add File) e si apre la classica finestra di apertura. Selezioniamo il file.m realizzato

4\ Deployment Tool

=B8] 8 |

con GUI editor, nel nostro caso

File Edit Tools Project Debug Desktop Window

D D FEM.m, che verra caricato
all'interno del nostro progetto.

|

Ded MR x (B & ?
. D_D_FEM.prj (Windows Standalone Application)
{1 Main function

. ~-#) D_D_FEM.m

+-{_] Other files

o C/C++ files

V| Generate Verbose Output
‘ Settings... ’

4\ Deployment Tool

T

= 3| R |

File Edit Tools Project Debug Desktop Window Help =~
0= d t:‘*?)(fé ,@- /g)

All'interno della cartella (Other files)
inseriamo i files che vengono richiamati
all'interno del programma realizzato
cliccando dal menu su (Project -> Add
File); si aprira la finestra da cui €
possibile selezionare i files desiderati e
quindi caricati all'interno della cartella.

. D_D_FEM.prj (Windows Standalone Application)
:—{:l Main function

-4__] Other files
]
v C/C+ 4+ files

V| Generate Verbose Qutput

Settings...




Compilazione del file D_D_FEM.m per ottenere il file D_ D _FEM.exe

Prima di procedere con la compilazione del progetto clicchiamo su (Project ->
Settings) che apre la seguente finestra:

g 5
4\ Deployment Project Settings (D_D_FEM.prj) ‘ o|B] = |
.. Project S;&ings .
Y m General Settings

=4 Toolboxes on Path
: S‘}acr;i;:ompller Project Type: Windows Standalone Application

=4 Packaging Application name: D_D_FEM

Version; |1 +|.|0 ~

Output Directories

Intermediate |:ekko\Desktop'file x presentazioe\2°versione\D_D_FEM\src Browse...

Output |ko\Desktop\file x presentazioe\2"versione\D_D_FEM\distrik

("] Generate Verbose Qutput

[¥] Embed CTF archive into the Application
MCR Options

[ Disable JVM at runtime

Compiler Options File:

Browse...

| ok |[ cancel |[ Help |

all'interno della quale é possibile impostare diversi parametri. Per il momento
lasciamo i parametri di default.




Compilazione del file D_D_FEM.m per ottenere il file D_ D _FEM.exe

Procediamo ora alla compilazione del file eseguibile. Nella finestra Deployment Tool
clicchiamo sull'icona Build the project presente nella barra degli strumenti.

4\ Deployment Tool

( =)

File Edit Tools Project Debug Desktop Window Help
e B MAX|E [Ee|?

. D_D_FEM.prj (Windows Standa|01A§4mmAq:_|
5-{88 Main function Build the project.

) DEYE

{1 Otherfiles

{1

Con l'avvio della compilazione, la
quale durera alcuni minuti, si apre la
finestra Deployment Tool Output

= @] % ]

5 =] SEZtxt
] C/C++ files

4\ Deployment Tool Output

Build output( 2010-12-29 12:34:14).

| Generate Verbose Output

[
L
Settings...

File Edit Tools Project Debug Desktop Window Help

N

mcc -F 'C:\Users\kekko\Desktop'file x presentazioe\2°versione\D D FEM. prf

Compilation in progress...

Al termine della
compilazione, la finestra
Deployment Tool Output
apparira come in figura

4\ Deployment Tool Output

o | @] &= |

File Edit Tools Project Debug Desktop Window Help

e e e R e L e T T

Compilation completed succesfully. The output is located in
C:\Users\kekko\Desktop\file x presentazioe\2°versione\Untitled1\distrib.

Compilation completed

You can package the component by clicking on the "Package” icon in the

4 [m]

P— —




Compilazione del file D_D_FEM.m per ottenere il file D_ D _FEM.exe

Per poter distribuire la nostra applicazione e quindi eseguirla su computer in cui
non ¢ istallato Matlab bisogna creare un pacchetto di istallazione che comprenda
oltre al nostro progetto anche il file MCR.exe.

1l Matlab Compiler Runtime ¢ la versione ridotta di Matlab necessaria per [’esecuzione dei
calcoli. Questo file e fornito con MATLAB Compiler e puo
essere distribuito a titolo gratuito.

Per maggiori informazioni visitare il sito:
http://www.mathworks.com/products/compiler/?BB=1.



http://www.mathworks.com/products/compiler/?BB=1

Compilazione del file D_D_FEM.m per ottenere il file D_ D _FEM.exe

Al fine di includere 'MCR.exe nel pacchetto di distribuzione clicchiamo su (Project
-> Settings) e selezioniamo la voce Packaging che apre la seguente finestra:

4\ Deployment Project Settings (D_D_FEM.prj) IM[

) Project Settings
% General
% Toolboxes on Path

‘ C/C++ Compiler Package Name: |D_D_FEM_pkgq
‘ Warning

Packaging Settings

(V] Include MATLAB Compiler Runtime (MCR)

MCR Location: |C:\Program Files\MATLAB\R2008a\toolbox\compiler\deploy\w

Additional Files:
Add required files not already included in the project.
Include files that are external to the MATLAB application and
that are needed for the MATLAB code to work correctly.

Add

Approximate package size before compression:236.191,445 KB

| ok || cancel || Help |

% = X

Nella parte destra spuntiamo la voce Include MATLAB Compiler Runtime (MCR)
e controlliamo che il percorso riportato nella cella MCR Location sia corretto.




Compilazione del file D_D_FEM.m per ottenere il file D_ D _FEM.exe

Ora possiamo creare il nostro pacchetto di istallazione cliccando sull'icona Package

the project nella barra degli strumenti del Deployment Tool.
=] E

4\ Deployment Tool
File Edit Tools Project Debug Desktop Window Help

RO x| B|&w 2

Anche questo processo puo durare

O @& |
.. D_D_FEM.prj (Windows Standalone Ap‘“@:ation]
=-{_] Main function [Package the project| . . .
o D_D_FEM.m a|Cun| mlnutl
‘?I u Other files 4\ Deployment Tool Output l»_.._—‘:’ B X |
B I | SEZ.txt
B o : File Edit Tools Project Debug Desktop Window Help N
""" L1 C/C++ files U_U_rEvi.exe :
readme. txt =
< [, . d »

V| Generate Verbose Output
@ Packaging in progress..
g B
4\ Deployment Tool Output =B8] % |
Al termine della creazione File Edit Tools Project Debug Desktop Window Help ¥
presentazioe\Z-versione\w_uU_rcivihaistrio R

del pacchetto, la finestra
Deployment Tool Output || The size of the package is: 228,077 MB
L i 5

4 |

apparira come in figura
Packaging completed




Compilazione del file D_D_FEM.m per ottenere il file D_ D _FEM.exe

Durante le operazioni di compilazione Matlab crea la cartella D_D_FEM nella quale
troviamo altre due cartelle denominate distrib e src. All'interno della cartella distrib
troveremo il file D_D FEM_ pkg.exe pronto per essere distribuito.

- | D_D_FEM
C Lj distrib
. L. [@&) _install.bat
... [0 D_D_FEM.exe
... [87 D_D_FEM _pkg.exe
o o 2] readmeitxt
[__J [j sTc
- || build.log
Lo E‘; D_D_FEM.exe
. 2] D_D_FEM_main.c
E] D_D_FEM_mcc_component_data.c
. || mecExcludedFiles.log

=

5o f_%] readme.bd

B D_D_FEM_pkg.exe



Realizzazione di un’applicazione WEB



Realizzazione di un’applicazione WEB

Grazie al compiler di Matlab si possono realizzare dei file.dll (dinamic link library) a
partire da un file.m.

Queste librerie contengono delle classi utilizzabili per la realizzazione di pagine WEB
dinamiche in formato ASPX come la seguente.

= =] R ]

G-
:é Calculation Services - Windows Internet Explorer

UU lé http://localhost:50376/Default.aspx v| 3 I "’] X l |/”/' AOL Cerca 2 - |

s = = - - - - = >>
5.7 Preferiti {éCalculationSeNices f'-'h - - ‘| = v Pagina~v Sicurezzav Strumentiv @~

-~

Calculation Services

Calculate Magic Square
Size: 5

Calculate

m

17241 815
23 5 71416
4 6132022
10121921 3
1118252 9

L v HTI5% v

Il €5 Intranet locale | Modalita protetta: disattivata ‘3




Realizzazione di un’applicazione WEB

La pagina vista prima € stata realizzata con il compilatore Visual Studio 2008 in
linguaggio C# il quale utilizza una dll realizzata con Matlab.

Il codice necessario per realizzare la pagina vista prima e reperibile nella guida in

linea di Matlab ricercando “Matlab Builder NE” oppure seguendo il link
http://www.mathworks.com/access/helpdesk/help/pdf doc/compiler/example quide.pdf.



http://www.mathworks.com/access/helpdesk/help/pdf_doc/compiler/example_guide.pdf
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Appendice

Siriporta di sequito i file.m che compongono il programma D _D FEM:
1. D D FEM.m

tabella_dati.m

sezioni.m

appapp.m

Incapp.m

iIncinc.m

inclib.m

plotdef.m
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plotmom.m
10. plotagl.m

11. ploterrm



